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1 Introduction

This practical will demonstrate how to use Parallelware Trainer to parallelize scientific software. The
example code used is based on the CORAL LULESH benchmark, simplified to enable completion within
the time of this tutorial.

2 Setting up Parallelware Trainer

2.1 Getting Started

Parallelware Trainer can be run on your laptop (preferred) or via remote execution on Boada. Please
note that for laptop installation you must be using Linux or have access to a Linux VM.

2.1.1 Laptop installation

1. Download the Parallelware Trainer tar.gz file from the website (www.appentra.com/a-hands-on-
intro-parallelware-trainer-2018/). This includes the tool and sample codes.

2. Move the downloaded tar.gz file to your desired installation directory.

3. Unpack the archive file and navigate to the unpacked directory:

$ tar xzf pwtrainer-0.5.3-x86_64-linux-ubuntu-14.04.tar.gz

$ cd pwtrainer-0.5.3-Linux

4. Download the example codes to your laptop from the website (www.appentra.com/a-hands-on-
intro-parallelware-trainer-2018/).

5. Launch the Parallelware Trainer tool:

$ ./pwtrainer &

2.1.2 Use remotely on Boada

To use Parallelware Trainer on Boada:

1. Connect to Boada using your PATC course account “nct010XX”:

$ ssh -YX <username>@boada.ac.upc.edu

2. Download the example codes to your account from the website (www.appentra.com/a-hands-on-
intro-parallelware-trainer-2018/).

3. Run the binary:

$ /scratch/nas/1/marenaz/pwtrainer-0.5.3-x86_64-linux/pwtrainer &
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3 Exercises

3.1 Parallel Trainer Walkthrough: Parallelizing the computation of π

Background: calculating π

The number π is a mathematical constant that was originally defined as the ratio of a circle’s circumfer-
ence to its diameter. With multiple equivalent definitions and uses it is commonly used in all areas of
mathematics and physics.

The calculation of π is common in many numerical libraries, with more specialized versions that have
been developed to calculate π and other common mathematical constants to any desired precision.

The code that you will work on in this exercise is a simple algorithm for calculating the π constant
and will allow you to understand how to use Parallelware Trainer.

Opening, building and running the project in Parallelware Trainer

For this course you are provided with a Parallelware project directory containing the source-code for the
calculation of π. To get started:

1. Click the ’Open project’ button (or press Ctrl+o, or via the menu File->Open Project) and select
the file ./samples/PI/PI.pw.

2. Select the ’Parallel’ execution console by clicking on the ’Parallel’ tab.

3. Build the project (press F5 or use the menu option Project->Build active profile).

4. Run the project (press F6 or use the menu option Project->Run active profile).

Setting up Parallelware Trainer for OpenMP threads

To set the number of threads in Parallelware Trainer:

1. Click on the settings button in the execution console, and then select the ’Parallel’ tab.

2. In the ’Pre-execution commands’ box select the command to set the environment variable for the
number of threads:
export OMP NUM THREADS=4

This will set the number of threads to 4. You may change this for benchmarking throughout the
tutorial.

Understanding the π code

1. Open the pi.c file (double click) from the project manager on the left hand-side of Parallel Trainer.

2. Click the ’Save’ button above the sequential code editor to start the Parallelware analysis. This
will add highlight marks next to the source-code line numbers.

3. Use the highlight marks to help identify your opportunities for parallelization:

• Green highlight mark for loops

• Blue highlight mark for functions

Further information about highlight marks is displayed in the analysis report in the Parallware
console. This will help you to understand the parallel patterns available to you and the possible
solutions for parallelization (the temporary variables, the parallel patterns and the ranking of
available parallelization strategies).
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Introducing parallelism

1. Open the pi.c file (double click) from the project manager on the left hand-side of Parallel Trainer.

2. Select the loop for analysis by clicking on the green highlight mark, then select options from the
pop-up dialogue to select ’OpenMP’ as ’Standard’ and ’CPU’ as ’Device’. Close the dialogue and
click ’Save’ button to produce a new source-code file pw pi.c with directives in the parallel code
editor in the right-hand panel.

3. Activate the parallel version pw pi.c by right clicking on the corresponding tab in the parallel code
editor and choose ‘Set as active version’.

4. Finally, you can build (F5) and run (F6) the OpenMP enabled source-code in the ’Parallel’ execu-
tion console using several values of OMP NUM THREADS.

Performance tuning

Iteratively test new options and strategies comparing the performance for each new directive. The pop-up
dialogue section ’Implementation of parallel reduction’ provides three different strategies for the parallel
implementation of the π calculation:

• ‘Atomic access’ - prevent race conditions on the reduction variable using OpenMP pragma atomic,
executing one atomic operation per loop iteration;

• ‘Built-in reduction’ - prevent race conditions on the reduction variable using the OpenMP clause
reduction, which avoids the atomic operation in each loop iteration;

• ‘Privatization’ - if you want to understand how the OpenMP reduction clause works, then choose
privatization to generate a parallel equivalent OpenMP code, with one atomic operation per iter-
ation. In instances where the built-in reduction does not support the reduction operator, privati-
zation can be used instead.

In each case, to implement the strategy do the following:

1. select the parallelization strategy of your choice;

2. type in the name of the reduction variable (sum);

3. press ’OK’ button in the pop-up dialogue and click ’Save’ button to update the parallel version
pw pi.c;

4. finally, build (F5) and run (F6).

3.2 Parallelizing a simplified version of LULESH: CORAL lulesh 2.0.3 mk

The aim of this exercise is to use Parallelware Trainer to introduce OpenMP directives into a real problem.
The sample code is based on the Coral benchmark LULESH.

The Livermore Unstructured Lagrangian Explicit Shock Hydrodynamics (LULESH)

A wide variety of science and engineering problems require modeling hydrodynamics, describing the
motion of materials relative to each other when subject to forces. LULESH is a highly simplifed ’proxy’
application, that represents the real challenges involved in the numerical simulation of hydrodynamic
problems. Developed by Lawrence Livermore National Laboratory (LLNL), it has been used extensively
in understanding how to reach exascale in applications.

The version, Lulesh mk, used in this example, has been developed for this course to provide a repre-
sentative piece of software, that can be parallelized in the time limitations of this course.
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Remote execution on MinoTauro

To gather performance results you will be able to run your code on Minotauro (more information about
Minotauro is available at https://www.bsc.es/user-support/mt.php. You will be able to directly connect
to the Minotauro job submission system via Parallelware Trainer:

1. Generate an ssh key so that Parallelware Trainer can connect to Minotauro using your credentials:

boada$ ssh-keygen// Generates new SSH key (press ENTER three times)

boada$ ssh-copy-id <username>@mt1.bsc.es // Transfer new SSH key to mt1.bsc.es

2. Edit the job submission script provided in ./samples/rCORAL lulesh 2.0.3 mk/res/mt1.config

to set your username:

Set \REMOTE_USER=<USERNAME>" // Your account \NCT010xx" at PATC

and ensure that the remote host variable is correctly specified:

REMOTE_HOST=mt1.bsc.es

3. Setup your profile: open ‘Settings’ for the Parallel execution console and in the Custom execution

script option select remote run on mt1.sh.

4. Run the project (press F6 or click “Play” button). This will run the job remotely on MinoTauro
and you will see the output and timing information in the ’Parallel’ execution console.

Parallelizing CORAL lulesh 2.0.3 mk

You should follow the steps that you followed in the walkthrough of the Pi project (above). This example
is significantly more complex and will require you to investigate more opportunities for parallelisation.

The key steps to follow are:

1. Open the CORAL lulesh 2.0.3 mk project in Parallelware Trainer by opening the file
./samples/CORAL lulesh 2.0.3 mk/CORAL lulesh 2.0.3 mk.pw.

2. Open the source code file CORAL lulesh 2.0.3 mk.c (double click) from the project manager.

3. Select the ’Parallel’ execution console, and build (F5) and run (F6) the project. Make sure you
record this sequential runtime in the results table at the end of the worksheet!

4. Parallelize the serial code using the OpenMP directives that you have learned so far, ensuring that
you review the messages in the Parallelware Console. The method for doing this is as follows.

(a) Select a highlight mark and use the pop-up dialogue to design how to parallelize the loop/function.
Do not forget to review the corresponding messages in the Parallelware Console to identify
the type of parallel pattern and associated variables.

(b) Using the pop-up dialogues, implement and test different design choices (e.g., atomic, priva-
tization for scalar reductions). Use Parallelware Trainer to help you identify when each of
these can be used.

(c) Once you have introduced the OpenMP directives benchmark the performance using different
numbers of threads (OMP NUM THREADS). Do not forget to record the parallel runtime and
speedup in the results table at the end of the worksheet!

(d) In some cases the parallelization strategy ’Privatization’ will require you to provide Parallel-
ware with information about the dimensions of arrays. In order to do so:

i. Open the pop-up dialogue by clicking on the green highlight mark.

ii. Select the ’Array ranges’ textbox in section ’Array ranges definitions’ and type A[lowerbound:length],
where A is the name of the array that is subject to the desired parallelization strategy,
consisting of length elements, from A[lowerbound] to A[lowerbound+nvertices-1].

iii. Next click the ’OK’ button in the pop-up dialogue to generate the OpenMP source code
in the file pw CORAL lulesh 2.0.3 mk.c.
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Finally, build (F5), run (F6) and record the runtime/speedup in the results table at the end
of the worksheet.

(e) Where possible focus on parallelizing multiple loops in order to minimize thread creation/destruction.
But note, this is not always possible due to dependencies that cross loop boundaries. To help
Parallelware Trainer identify the opportunities available, select a region by using the PW
pragmas:

// These are two sequential (non-nested) loops

#pragma pw section

{

loop 1 {

... code ...

}

loop 2{

... code...

}

} //ends the pragma pw section

A Further information

Useful information:

• You may also refer to the user manual (https://www.appentra.com/wp-content/uploads/2018/05/Parallware-
Trainer-User-Manual.pdf).

• Sign up to the Appentra newsletter: www.appentra.com/blog/newsletter/.

• Email us at: info@appentra.com

• Download and purchase Parallelware Trainer: www.appentra.com/products/parallware-trainer

B Write your personal notes here...
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[PLEASE RETURN TO THE INSTRUCTOR]
[IF YOU WOULD LIKE A COPY OF YOUR RESULTS PLEASE ASK THE

INSTRUCTOR]

Experimental results for CORAL lulesh 2.0.3 mk

You may wish to use the following table to record your results and to help identify the best combination
of parallelization strategies.

Code version / notes OpenMP Runtime (s) Speedup

threads Time 1 (s) Time 2 (s) Time 3 (s) Mean (s) T(seq)/T(mean)

Sequential 1
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